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White paper
STYLISTIC Q550 Windows 7 User
Experience Optimization

Enhance the Windows 7 Tablet experience

STYLISTIC Q550 Baseline
Windows 7 Touch Optimizations
Windows 7 OS Optimizations

STYLISTIC Q550 Baseline

Optimization recommendations assume the latest driver updates applied to a clean system image.

System Image should be free of unnecessary applications and add-ons to ensure optimal user experience.
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Windows 7 Touch Optimizations

Display/DPI Setting and Magnification
For ease of selecting items on the screen, enlarge appearance of objects.

Increase DPI to magnify all objects on the screen.
The Windows 7 Display setting default is “Smaller- 100%"” which equates to 96 DPI.

4| Custom DPI Setting ﬂ

g_) | » Control Panel » All Control Panel kems » Display = | 3 [ll Search Control Panel |
@ For a custom DPI setting, select a percentage from the list, or
drag the ruler with your mouse.

Control Panel Home a . "
Make it easier to read what's on your screen

Adjust resolution You can change the size of text and other items on your screen by choosing ene of these ECB|E to this percentage of normal size: 100%
options. To tempararily enlarge just part of the screen, use the Magnifier taol.
Adjust brightness — T

) Calibrate color
@ Smaller - 100% (default) Preview
Change display settings -

| | | |
Connect to a projector ] 25 |2 13
Adjust ClearType text © Medium - 125%

9 point Segoe U1 at 96 pixels per inch.
Set custom text size (DP])

See also

Personalization

Apply [¥] Use Windows %P style DPI scaling oK ] ’ Cancel

Devices and Printers

Select “Medium -125%" which equates to 120 DPI.
Control Panel -> All Control Panel Items -> Display -> “Medium - 125%”

Custom DPI Setting

B2 ) Control Panel » All Control Paneltems » Display Search Control Panel

For & custom DPI setting, select a percentage from the list, or
drag the ruler with your mouse.

Control Panel Home y 3 p
Make it easier to read what's on your screen

You can change the size of text and other items on your screen by choasing one of these

Adjust resolution
options. To temporarily enlarge just part of the screen, use the Magnifier tool.

Adjust brightness
B Calibrate color

Scale to this percentage of normal size:

% ) Smaller - 100% (default) Preview
Change display settings | |
Connect to a projector 10 i

Adjust ClearType text ®@ Medium - 125%

Set custom text size (DP)

9 point Segoe UI at 120 pixels per inch.

See also

Personalization

1. Some items may not it on your screen if you choose this setting while i i L ] [
et endibaairs - b Y ¥ 9 Apply R Use Windows XP style DPI scaling | oK ; Cancel

your display is set to this resclution,

Important Note(s):

The STYLITSIC Q550 North American preinstall image default is “Medium -125%” - 120 DPI.

Modifying the DPI can affect compatibility of certain custom software applications. When changing DPI ensure changes do
not affect custom software applications.

Enable Microsoft Magnifier by default
Use Windows 7 Magnifier to allow users to zoom in /zoom out when navigating.
Control Panel-> All Control Panel Items -> Ease of Access Center-> Start Magnifier

To easily access the magnifier (similar to how Tablet PC Input panel floats); consider pinning the Magnifier setting box to the
taskbar.
When the program is already running, right-click the program's button on the taskbar to open the program’s Jump
List, and then click Pin this program to taskbar.
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Enlarge caption buttons and scroll bar

The minimize, restore down, and close buttons are small and close together making it difficult to select when using touch
only navigation. Additionally, the default scroll bar size is not optimal for touch only navigation.

Increase the size of these Buttons and Scrollbar
Control Panel -> All Control Panel Items-> Personalization->
Window Color -> Window Color and Appearance -> ltem

Window Color and Appearance

Inactive Window -10] x|

Active Window -|o] x|
Mormal Selected

Window Text .‘J
Message Box x|

Message Text

=]
0K

To turn on Windows Aero, select a Windows theme. Colors and sizes
selected here apply only if you have selected the Windows 7 Basic
theme or an Ease of Access theme.

Item: Color 1
Desktop - —i_v‘ -
bl o ~| | B
[ox ][ conce

Item -> select [Caption Buttons]
EX: Change size to 35 or other user preferred value for larger button size.

Item -> select [Scrollbar]
EX: Change size to 28 or other user preferred value for a wider scrollbar.

=TT | e e

Search Sample Pictures 2 [

Search Sample Pictures jel |
= - 0 @ _
Er =~ [ @
Arrange by: Folder «
Arrange by: Folder =

m

Jellyfish

Hydrangeas Jellyfish

Default (L) VS Example (R) Settings

Important Note:
These setting modifications best made after adjusting DPI.
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Switch from Double-Click (default) to Single-Click to open items
By using single click, the user experience will be similar to competitor’s tablets/slates. In addition, improves perception of
quicker program/application access/launch with single click.

Windows Explorer -> Organize - > Folder and search options -> General

General | View | Search

Browsze folders
@) Open each folder in the same window

() Open each folder in its own window

Click tems as follows

“i=5 @) Singleclick to open an item (point to select)
M (©) Underling icon titles consistent with my browser
@ Underine icon titles only when | poirt at them
() Double-click to open an tem (single-click to select)

Mavigation pane
[ [ Show all folders
¢ [[] Automatically expand to cumrent folder

How do | change folder options?

Important Note:

Recommend users carefully evaluate this setting prior to mass adoption.
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Enable User check boxes for selecting files/directories in Windows Explorer

It is common for users to use Ctrl key to select multiple files in a directory that are not in consecutive order. In touch only
systems, this may be difficult to do without easy access to the Ctrl key.

A setting in Folder Options “Use check boxes to select items” can be enabled such that a checkbox will appear next to each
file in a directory so that user can easily select the files needed.

Windows Explorer -> Folder and search options -> View -> Check “Use check boxes to select items”

Important Note:

Recommend that the Double-Click and User check boxes Optimizations be applied together.

Folder Cptions

-

|Genem| | View |Search|

Folder views

You can apply the view (such as Details or lcons) that
you are using for this folder to all folders of this type.

[ Applyto Folders | | Reset Folders

Advanced settings:

Hide extensions for known file types
Hide protected operating system files (Recommended)
[ Launch folder windows in a separate process
[] Restore previous folder windows at logon
Show drive letters
Show encrypted or compressed MTFS files in color
Show pop-up description for folder and desktop tems
Show preview handlers in preview pane
0
Use Sharing Wizard (Recommended)
When typing inta list view
0 Automatically type into the Search Box

m

Restore Defaults

oK || cancel ||

Apply

|

Page 5 of 10

Information shared under NDA

solutions.us.fujitsu.com



White paper STYLISTIC Q550 Windows 7 Optimization

Tablet Input Panel (TIP)
The TIP default is to float and can be difficult to launch from the side of screen. Configure the TIP to show on the taskbar,
so the user can easily launch in a touch environment.

TIP -> Tools -> Options -> Opening -> Check “Show the icon in the taskbar”

| Text completion I Inserticn | Advanced
Opening | Handwriting | Ink to text conversion

Input Panel icons and tab

Choose which action opens Input Panel:
i@ Tap the Input Panel icon or the tab
(71 Point to the Input Panel icon or the tab

Choose where to show the Input Panel icons and tab:

For tablet pen input, show the icon next to the text box
Fortouch input, show the icon next to the text box
[#]:Show the icon on the taskbar:

Use the Input Panel tab

[7] Show the tab even when the pen is gut of range

Show Input Panel sliding open from the tab
Choose where the tab appears:
@ Left edge of the screen

71 Right edge of the screen

Learn more about opening and moving Input Panel

There are a few other options on configuring TIP. When considering which option to use, factor in the form factor. The TIP
configuration can be float, docked at the top, or bottom of the screen. For smaller PCs, docking the TIP will mean losing
screen space.

TIP -> Tools -> Docking -> (Float, Dock at top of screen, Dock at bottom of screen)

Show expanded kegbowd

¥ | Float Docking
Dok at top of scresn
Dok o bettem of fibin

Hizlp tepics
Options

=y

Shift

Ctrl i
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Show touch pointer during screen interaction (translucent mouse)

Enable touch point (translucent mouse) during screen interaction. This will make right clicking easier.

Caveat: Having the translucent mouse appear every time using pointer may not be appealing for some users so review this

setting carefully.

Control Panel -> All Control Panel Items -> Pen and Touch -> Touch -> Check “Show the touch pointer...”

| Pen Options | Flicks | Handwriting | Touch | Panning|

[¥]| use your finger as an input device
J'| Enable multi-touch gestures and inking
Touch actions

Use your finger to interact with items on the screen. You
can adjust the settings for each touch action,

Touch action Equivalent mouse action
| Double-tap Double-click

| Fress and hold Right-click

Touch painter

@?Sbuw the touch pointer when I'm interacting with
items on the screen, [}

Agvanced Optiors...

[oc J[ camcet || apov |
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Windows 7 OS Optimizations

Windows 7 Theme

Disable the standard Windows 7 Aero theme for increased performance and responsiveness.
Control Panel -> All Control Panel Items -> Personalization-> Windows 7 Basic

";" Q’ & » Control Panel » All Control Panel Items » Personalization

Control Panel Home

Change desktop icons
Change mouse pointers

Change your account picture

See als
Display
Taskbar and Start Menu

Ease of Access Center

L

- Search Control Panel pe)
o|

Change the visuals and sounds on your computer

Click a theme to change the desktop background, window color, sounds, and screen saver all at

Onge.

Landscapes

Windows T Basic

Desktop Background

Harmary

Mature

Basic and High Contrast Themes (&)

Windows Classic

|

Window Color

A

Sky

Scenes

High Contrast #1

—
=

22

Sounds Screen Saver

Windows Default MNomne
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Disable unnecessary visual effects

In addition to changing the Window 7 theme, tailor the Windows operating system visual effects to improve performance.

Control Panel -> All Control Panel Items -> System -> Advanced system settings ->

System Properties -> Advanced -> Performance -> Settings

Visual Effects -> select “Custom” and disable all effects and enable only the following:

Show thumbnails instead of icons

Smooth edges of screen fonts

Use drop shadows for icon labels on the desktop

Use visual styles on windows and buttons

Control Fanel Home

"J Device Manager

?;" Remote settings

";’ System protection

-'H Advanced system settings

See also
Action Center
Windows Update

Perfarmance Information and
Tools

@-Ovlh » Control Panel » All Control Panel lkems » System

- | e ] | | Search Control Panel 2 |

System Properties ed |

|CumputmNanm[Hamam Advanced SysbemF‘rulechon| Rarnubel

“ou must be logged on as an Administrator to make most of these changes.

Pedormance
Wisual effects. processor scheduling. memary usage. and virual memory

Setings...

Liser Profiles
Diesktop sefings related to your logon

Settings... ]

Starup and Recovery
System starup, system failure, and debugging information

Settings...

Ervironment Varables.., ]

Performance Options
Visial Effects Aduanned] Data Execution Prewennnnl

Select the settings you want to use for the appearance and
performance of Windows on this computer.

[T Let Windows choose what's best for my computer
() Adjust for best appesrance

) Adjust for best performance

@) Custom:

|[] Animate cantrots and elements inside windows
|| Animate windows when minimizing and maximizing
[ Animations in the taskbar and Start Menu

|_ Enable deskiop composition

[ Fade or dide menus inla view

[ Fade or shde ToolTips into view

|| Fade out menu items after clicking

|[7] save taskbar thumbnail previews

|_' Show shadows undar mouse poinder

[ Show shadows undar windoves

[¥] Show thumbnails instead of Icons

|| Show translucent selection rectangle

|["] show window contents while dragging

[ lide open combo boxes

|[w] Smooth edges of screen fonts

[ smiboth-seroll list boxes

|+ Use drop shadews for icon labels on the desktop
|[¥] use visual stydes an windows and bButtons

| oK _il Cancel | Apply |
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Windows 7 Power Profile

The Fujitsu America Image Power Profile is Power saver to offer longer battery life. The system performance can increase at
the expense of battery life.

Windows 7 offers Power saver, Balanced and High performance. Each Power Profile controls the CPU performance /
frequency (and commensurate power usage) based upon the system computing needs and power operations (battery or
AC adapter).

The standard Windows 7 High performance Power Profile will allow the CPU to remain at 100% when on AC Adapter and
throttle between 5% and 100% when on battery.

Control Panel -> All Control Panel Items -> Power Options -> Show Additional Plans -> High performance

;‘é" Power Options M

Advanced settings |

and then choose settings that reflect how you want

\ i Select the power plan that you want to customize,
your computer to manage power.

% Change settings that are currently unavailable

High performance -

= Processor power management -
Minimum processor state
On battery: 5%
Plugged in: 100%
= System cooling policy
On battery: Active
Plugged in: Active =
Maximum processor state
On battery: 100%
Plugged in: 100%

Tl Nienlaw

Restore plan defaults

Important Note:
The selection of High Performance or Balanced Power Profiles can reduce battery life and recommend users carefully
evaluate this setting prior to mass adoption.

© 2011 Fujitsu America, Inc. All rights reserved. The information in this document is subject to change without notice.

Fujitsu America makes no warranty of any kind with regard to this material, including, but not limited to, the implied warranties of
merchantability and fitness for a particular purpose.

Fujitsu America shall not be liable for errors contained herein, or for incidental or consequential damages in connection with the furnishing,
performance, or use of this material.

No part of this document may be reproduced, photocopied, transcribed into a different medium or format, or translated to another language
without the prior written consent of Fujitsu America.

Page 10 of 10 Information shared under NDA solutions.us.fujitsu.com



